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Preface 
The Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 
Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the 
latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web 
site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available 
on your network from which you can access the Agile PLM documentation (PDF) files. 

Note  To read the PDF files, you must use the free Adobe Acrobat Reader version 7.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help > Manuals 
in both Agile Web Client and Agile Java Client. If you need additional assistance or information, 
please contact support http://www.oracle.com/agile/support.html 
(http://www.oracle.com/agile/support.html) for assistance. 

Note  Before calling Oracle Support about a problem with an Agile PLM manual, please have 
the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html

Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  
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Chapter 1 

Introducing ChangeCAST 

This chapter includes the following: 

 About ChangeCAST ............................................................................................................................................ 1 
 Some Important Definitions ................................................................................................................................. 3 
 The ChangeCAST Window.................................................................................................................................. 4 
 Starting ChangeCAST ......................................................................................................................................... 10 
 Getting Help......................................................................................................................................................... 11 
 Where to Go From Here ...................................................................................................................................... 11 

ChangeCAST works with target system-specific profiles to update your target systems with the 
latest Item, Bill of Material (BOM), and Manufacturer information from Agile. 
 

About ChangeCAST 
ChangeCAST coordinates the flow of information from the Agile database to the target system, as 
shown below. 

 
1. Profiles are created within ChangeCAST. They control: 

 The format of and naming convention for ChangeCAST transfer files 
 The destination of ChangeCAST transfer files 
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 Whom to alert in case of errors (Notification) 
 How often ChangeCAST polls for change orders and MCOs and transfers them (Schedul

Profile 

e) 

2. 
x, although you can rename it for distribution. Only one profile library can be 

3. uch as Parts and Documents) and release them by creating and 

4. 
r change 

5. tes a transfer file for each 

ne file or a set of files per released change order 

6. 

 the transfer file, it validates the data 

nchronize up to 32 different target systems with the data in the Agile system, 

libraries (sets of profiles) can contain up to 32 profiles. The active profile library is  
ChangeCAST.ag
active at a time. 

Agile users create Items (s
releasing change orders. 

ChangeCAST checks for released change orders or MCOs. When ChangeCAST is in the 
Resumed connection state, it periodically polls the Agile database and checks fo
orders and MCOs that have been released but not transferred per each profile. 

If ChangeCAST finds any released change orders or MCOs, it crea
enabled profile, according to the format settings for those profiles. 

That is, the change order information translates (as per the settings in the enabled profiles) into 
properly formatted transfer files and the files (o
or MCO) are stored at the specified locations. 

Depending on the destinations stored in the profiles, the files are either processed by a local 
application adapter, or transferred by FTP to a target system host(s) for processing. If the 
application adapter at the host target system site receives
and sends the data to the host target system’s database. 

ChangeCAST can sy
as illustrated below. 
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Some Important Definitions 
llowing terms will help you understand and use ChangeCAST and related files. 

neral terms and describes the ChangeCAST components and the various 
 files. 

Termi

Understanding the fo
The following table lists ge
ChangeCAST

nology 

Term Def in i t ion  

General Terms

Attributes
eld 

A list of target system table-field elements that can be mapped; every profile 
contains a set of attributes. The terms target system attribute and target system fi
are used interchangeably in this manual. 

ChangeCAST 
connect state 

Whether ChangeCAST is automatically transferring change orders for enabled 
profiles; the possible states are Paused and Resumed, controlled by buttons in the 
main ChangeCAST window. 

Field
al. 

An individual piece of information; an attribute or column of a table. The terms target 
system attribute and target system field are used interchangeably in this manu

Mapping The pairing of target system attributes with Agile fields, system nulls, system 
variables (also known as system flags), or the result of a conditional expression. 

Profile le 
om Agile to a 

A collection of settings used by ChangeCAST to process and deliver the transfer fi
to the target system. Profiles define many aspects of data transfer fr
single target system, including transfer file structure definition, transfer settings, 
scheduling information, data mapping, and directory/file locations. 

Profile library Up to 32 profiles together in a single file with extension .agx (for ChangeCAST 8.1 
and later) or .agc (for previous releases). 

Row A grouping of fields or a record in a table that represents a data element. 

Table An organized collection of records. 

Transfer flag An internal setting that tells ChangeCAST whether a change order has been 
successfully transferred. 

Released

es—provide 

includes a Complete-type status, it is the last status in the workflow. 

ChangeCAST checks for newly released change orders and MCOs (Manufacturer 
Change Orders). 

A change order or MCO is considered released when it enters the first Released-
type status in the workflow. 

Only the first Released-type status actually releases the routable object. 
Subsequent Released-type statuses—given distinguishing status nam
additional review/approval cycles for the released routable object. If the workflow 
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Term Def in i t ion  

Change Order
MCO

ChangeCAST transfers both change orders (Change Order Class objects) and 
MCOs (Manufacturer Change Order Class objects). 

ChangeCAST components

ChangeCAST 
Service

A service that launches the ChangeCAST application, ChangeCAST.exe. 

ChangeCAST.exe An application used to configure and transfer files of Agile data to a host target 
system. 

StartChangeCAST.
exe

An application that starts the ChangeCAST Service. 

ChangeCAST files

Backup (.bak) Backup of the Profile library. 

Error log 
(ErrorLog.txt)

A log file that tracks ChangeCAST mapping, condition syntax, and other problems 
encountered during validations and audits. 

Exported 
ChangeCAST 
attribute file (.aga)

An ASCII text file containing a list of target system tables and fields that are 
mappable for a single ChangeCAST profile. 

Mapping file 
(.map)

An ASCII (text) file containing the mappings of Agile fields to target system fields. 

Profile library or 
(.agx.agc)

A file that contains all aspects of one or more profiles. AGX files (for the current 
ChangeCAST) are text files. AGC files (the format for pre-8.1 releases of 
ChangeCAST) are binary files. 

Temporary 
(.agl.tmp)

Temporary files created during processing. 

Transfer file
(.agl, by default)

A formatted ASCII file, output from ChangeCAST, which is used to transfer change 
order information from Agile to a host target system. There is at least one transfer 
file for every change order processed by ChangeCAST. Transfer files adhere to the 
settings defined in corresponding profiles. 

Transfer log 
(TransferLog.txt)

A log file that tracks the status of ChangeCAST’s connect state and transfer 
attempts. 

 
 

The ChangeCAST Window 
When you launch ChangeCAST, the ChangeCAST window appears. The ChangeCAST window 
has these main features, described in the following sections: 

 Title bar 

 Menu bar 

 Toolbar 
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 Profile Library table, which displays all the profiles in the profile library (ChangeCAST.agx) and 
their current transfer status 

 Transfer Log table, which shows status messages from the last few data transfers 

 Status bar 

 Profile library buttons 

 Transfer control buttons 
 

Title Bar 

The title bar at the top of the ChangeCAST window contains the application name; the title bar at 
the top of most dialog boxes contains the currently selected profile. 

Menu Bar 

The ChangeCAST menu bar includes the menu options listed below: 

Menu Act ions  

File Minimize application window, log in as a different user, exit. 

Edit Set launch options, enable differentiation between parts/documents and ECOs/MCOs. 

View Display and clear the Transfer and Error logs. 

Profile Add, rename, copy, import, remove, and audit profiles. 

Mapping Create, modify, import, and export Agile-to-target system field mappings and attributes. 

Format Define the format of transfer files. 

Transfer Define the destination, transfer type, email notification, file format, application adapter post-
processor, and schedule for Agile-to-target system data transfers. 

Reports Produce a variety of reports for the current profile, all profiles in the library, or the Agile 
tables; reports are created as .txt files. 

Help Display online Help or ChangeCAST version and copyright information. 
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Toolbar 

The ChangeCAST toolbar offers the shortcuts for menu commands described below: 

Button  Act ions  
Equation 1: -2: 
ChangeCAST 

 
Add Profile

Opens the Add Profile dialog box for adding new profiles. 

Equation 2: -2: 
ChangeCAST 

 
View Log File

Opens Windows Notepad and displays the Transfer log file (for all 
profiles). 

Equation 3: -2: 
ChangeCAST 

 
Edit Mapping

Displays the Field Mappings dialog box for the current profile so you 
can create, modify, add, import, or export Agile-to-target system field 
mappings. 

Equation 4: -2: 
ChangeCAST 

 
Format Options

Displays the File Format dialog box for the current profile so you can 
define or modify its transfer file format. 

Equation 5: -2: 
ChangeCAST 

 
Transfer Options

Displays the Transfer Options dialog box for the current profile so you 
can enter or modify its transfer file destination, email error notification 
list, file naming scheme, and transfer schedule. 

Equation 6: -2: 
ChangeCAST 

 
Audit

Validates mappings for the selected profile, including checks for valid 
attributes and syntax; errors are written to the ChangeCAST Error Log. 
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Profile Library Table 

The Profile Library table manages ChangeCAST profiles. It displays all profiles that have been 
created or imported into the profile library file, ChangeCAST.agx. The profile library can contain up 
to 32 profiles.  

Profile Library Fields 

The Profile Library table contains the fields described in the table below. The list below shows the 
order the profiles are processed. 

Field  Descr ipt ion 

Profile The name given to the current profile. 

Description An optional note describing the current profile. 

Enabled Whether the profile is active (Enabled) or not (Disabled). 

Last CO The number of the last change order transferred, for example EC23-2200. 

Last Transfer 
File

The name of the transfer file for the last change order transferred — for example, 
AG000023.agl. 

Status The transfer status of the last transfer attempted, whether successful (Success) or not 
(Failed). 

Date/Time The date and time the last transfer was attempted (the Status field was updated). 

 
 

Profile Library Buttons 

Listed below are buttons, which help you manage profiles. You can find them to the right of the 
Profile Library table. 

Button  Act ion  

Enable Activates the current profile and changes the Enabled field to Yes, after first auditing 
the mappings. 

Disable Deactivates the current profile and changes the Enabled field to No. 

Move Up Moves the current profile up one row in the Profile Library table (profiles are processed 
in the order shown in the table, top to bottom). 

Move Down Moves the current profile down one row in the Profile Library table. 

Import Displays the Import Profile dialog box so you can import a profile from another profile 
library file (*.agx or *.agc). 
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Transfer Log Table 

The ChangeCAST Transfer Log table contains the last several lines from the Transfer log file, with 
the most recent transaction listed at the bottom of the view. To view the entire Transfer log, click 
View Log. 

Transfer Log Contents 

Each logged transfer transaction contains the fields described in the table below. 

Field  Descr ipt ion 

Date/Time The date and time of the current transfer attempt (log entry). 

Change # The number of the current change order, for example EC23-2200. 

Filename The name of the transfer file for the last change order transferred, for example 
AG000023.agl. 

Transfer Status Comments indicating whether the transfer was successful or not and additional 
information about the transfer, if appropriate. 

Destination The FTP site or local directory where the file was to have been transferred. 

Status The transfer status of the last change order transferred, whether successful (Success) 
or not (Failed). 

Other event information also appears in the Transfer log. For details, see Viewing and Printing Log 
Files on page 43. 

Transfer Control Buttons 

The buttons described in the table below control transfers. These buttons are located to the right of 
the Transfer log. 

Button  Act ion  

Pause Stops the ChangeCAST polling schedule and transfer of change orders for all enabled 
profiles. 

Resume Starts the ChangeCAST polling schedule. 

Transfer Now Processes and transfers all change orders that have been released and not transferred for 
all enabled profiles; this is not dependent on the connection state or current schedule. 

View Log Opens Windows Notepad and displays the entire Transfer log. 
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ChangeCAST Status Bar 

The status bar at the bottom of the ChangeCAST window displays the current ChangeCAST state 
(Paused, Resumed, or Processing), the name of the current logged-in user, and the name of the 
Agile server host computer. 

Upgrading from a Previous Version 

Before using ChangeCAST and attempting to upgrade from a previously installed version, you 
should be aware of the following issues: 

 Fields on the Page Three tab cannot be mapped and transferred using ChangeCAST. 

 Flex field is a custom field created by the customer. ChangeCAST does not transfer any flex 
field, though the flex field is visible in the mapping. 

 The year is always stored in 4-digit format. Check the macros that accommodate this format. 
Any 2-digit years are automatically changes to the 4-digit format. 

 If there is MCO-specific data that you want to transfer, you must map those fields. 

 Only one ChangeCAST session may be running per the Agile Application cluster. 

 By default, the Administrator role does not include privileges necessary to perform Change 
Analyst tasks. The Change Analyst role should include the following privileges for each type of 
object: Read, Create, Discover, Reports, Global Search, Modify, and Send. 

Note  If your company is using ChangeCAST, in most cases not all users should be able to 
unrelease change orders (or MCOs) in Agile. To avoid having a change order 
unreleased after ChangeCAST transfers it, the Unrelease privilege should not be 
granted to any users. ChangeCAST does not automatically re-send Unreleased 
change orders. 

To upgrade ChangeCAST on a system where a previous version of ChangeCAST is installed: 

Starting ChangeCAST

1. Install ChangeCAST on the computer that contains the earlie

2. Ensure you have appropriate Read and Discover privileges. 

r release of ChangeCAST. 

3. Ensure you have the highest-level Product Collaboration user license to run a session of 
ChangeCAST. 

Contact your Agile administrator if you do not have the required license. 

4. Start ChangeCAST, as described in  on page 10. (The Agile Application 
server must be running.) 

5. Ensure that profiles and settings are correct. If necessary, build ChangeCAST profiles, or use 
profiles provided by a ChangeCAST implementer. Create or modify field mappings, if 
necessary. 

Note  Ensure to validate the changes after you modify a profile, completed by an 
implementer.  

For details on importing and using existing profiles, see Working with Profiles on page 13. 
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For information about building new profiles, see the Agile ChangeCAST Developer Guide. 

For information about creating, modifying, and verifying field mappings, see Defining Attributes 
and Mapping Fields on page 19. 

Configure and verify ChangeCAS6. T transfer settings, including a polling schedule. Enable the 

For details, see Formatting and Transferring Data Files

profiles and start ChangeCAST. 

 on page 35. 

Starting ChangeCAST 

2. ngeCAST Server. The system prompts you to login 

3. 
, its connection state is Paused (the Pause button is grayed and the Resume button 

Minimizing On Launch 

eCAST behaves when launched (choose Options from the Edit menu to display that dialog 

unch behavior for different Minimized On Launch settings and 
C T conne tates. 

 

To start ChangeCAST: 

1. Choose Start in the taskbar. 

Choose Programs | Agile | Agile 9.3 | Agile Cha
with your Agile username and password. 

If you have appropriate privileges, the ChangeCAST window appears. The first time you launch 
ChangeCAST
is available). 

 

You can use the Minimized On Launch setting in the Options dialog box to determine how 
Chang
box). 

The following table summarizes la
hangeCAS ction s

Minimize  
On Launch 

Last  
Conne

 
ct  State  Launch Behavior  

Not checked Paused When you launch ChangeCAST, you are prompted to log in. The 
ChangeCAST window opens and the connection state is Paused. 

Not checked Resumed

rders for 

When you launch ChangeCAST, you are prompted to log in. The 
ChangeCAST window opens, and the connection state is Resumed. 
(ChangeCAST starts connecting and transferring change o
each enabled profile according to the schedule settings.) 

Checked Paused
 the system tray. The 

icon indicates the connection state is Paused. 

When you launch ChangeCAST, ChangeCAST automatically logs in 
as the previous user and appears as an icon in
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Minimize  
On Launch 

Last  
Connect  State  

 
Launch Behavior  

Checked Resumed When you launch ChangeCAST, ChangeCAST automatically logs in 
as the previous user and appears as an icon in the system tray. The 
icon indicates that the connection state is Resumed and 
ChangeCAST is processing change orders according to schedule 
settings. 

Note: With these settings, ChangeCAST can process change orders 
before a user has logged in to Windows NT or Windows 2000 Server. 
This option allows ChangeCAST to process ECOs after the computer 
has restarted, without intervention. If the Agile application is not 
running, ChangeCAST will wait for it to start. 

To maximize ChangeCAST window, click the icon in the system tray. The system prompts you to 
enter your password before the ChangeCAST window opens. 

When you are able to configure ChangeCAST, click the Resume button to start it. For details, see 
Starting and Stopping ChangeCAST on page 43. 

Logging In As a Different User 

You can login as a different user, if another person is using ChangeCAST. 

To log in as a diferent user: 

 If the ChangeCAST window is open, choose Log In As A Different User from the ChangeCAST File 
menu. 

 If ChangeCAST is minimized to the system tray, right-click the icon in the system tray and 
choose Login As A Different User from the shortcut menu. 

 

Getting Help 
The online Help system for ChangeCAST contains descriptions of dialog boxes, menu commands, 
and other ChangeCAST features. Online Help is available from dialog boxes and the Help menu.  

 To view information about a dialog box, click its Help button.  

 For general Help, choose Contents from the ChangeCAST Help menu. 

 For ChangeCAST version and copyright information, choose About ChangeCAST from Help 
menu. 

 

Working with Profiles

Where to Go From Here 
With ChangeCAST running, you are ready to create new profiles or load and verify existing profiles. 

  on page 13 describes how to import and manage profiles. 

 pping FieldsDefining Attributes and Ma  on page 19 describes how to define and modify field 
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attributes and mappings.  

 ng Data FilesFormatting and Transferri  on page 35 describes how to set and verify file transfer 
settings. 
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Chapter 2 

Working with Profiles 

This chapter includes the following: 

 Creating and Managing Profiles .......................................................................................................................... 13 
 Using Profiles....................................................................................................................................................... 18 
 Distributing Profile Libraries................................................................................................................................. 18 

Profiles configure virtually all areas of ChangeCAST performance. A ChangeCAST profile is a 
group of settings that define many aspects of data transfer from Agile to a single target system. 
These aspects include transfer file structure, transfer file delivery, scheduling information, email 
notification lists, and data mapping. Profiles are used in the creation of transfer files. 

All the profiles together make up a profile library. Only one profile library can be active at a time. 
The default profile library is ChangeCAST.agx, located in the same directory as ChangeCAST.exe. 
For other important definitions needed to work with ChangeCAST, see Some Important Definitions 
on page 3. 
 

Creating and Managing Profiles 
When you first install ChangeCAST, the profile table is blank, and ChangeCAST prompts you to 
create a default profile. You can create and import up to 32 profiles. 

Note  When you launch ChangeCAST, a list of all available profiles appears in the upper table 
of the ChangeCAST window. 

 

Adding and Importing Profiles 

You can create a profile in the ChangeCAST profile library by adding a new profile or importing one 
from another profile library. Once you create a profile, you can copy, rename, or remove it. 

Note  Since the profile library saves automatically, the Save or Open commands, do not appear 
on the File menu. 

 When you change the connection state to Resume, click OK in the dialog box after each 
transfer, or when you exit ChangeCAST.  

 

Adding a New Profile 

To add a new profile:  

1. Choose Add Profile from the Profile menu, or click the Add Profile toolbar button.  

2. Enter appropriate information in the Add Profile dialog box and all dialog boxes accessible from 
it. 
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3. Click OK to save the new profile to the profile library. 

Note  Creating a new profile from scratch is a detailed process. The completed profile must 
exactly match the format requirements of the target system. For best results, follow the 
methodology outlined in the Agile ChangeCAST Developer Guide. 

 

Importing a Profile 

For best results, store import source files (other profile library files) in a separate subdirectory, such 
as Profiles, located under the ChangeCAST program directory. 

Note  Do not to overwrite any files in the ChangeCAST program directory when bringing in 
source files. 

To import a profile from a ChangeCAST profile library (.agx or .agc file): 

1. Choose Import from the Profile menu. The Import Profile wizard appears. 

2. Select the type of profile library from which to import, click Next. 
3. Use the Open dialog box to select the target .agx or .agc file, and then click Open. Step 2 of the 

wizard appears. 

4. Select profiles to import from the profile library. To select all profiles, click Select All. To deselect 
all profiles, click Deselect All. 

5. After selecting the profiles to import, click Next. Step 3 of the wizard appears. 

6. Specify the Change Order Transfer Setup option that you want. The choices are: Keep transfer 
state settings, Set all change orders as transferred, Set all change orders as NOT transferred. (For 
additional information about these options, click the Help button in the wizard.) 

7. Under Profile Library Options, specify whether you want to add the new profiles to the active 
profile library or completely overwrite the active profile library. (If you overwrite the active one, 
ChangeCAST creates a backup copy in the ChangeCAST program directory.) Click Finish to 
import the profiles. 

8. Check the imported profile name for uniqueness. If you find a duplicate in the profile library, the 
system prompts you to enter a new name or to skip that profile. 
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By default, the new profile is disabled. 

Note  When you import a profile, you will need to edit the mappings and set transfer options 
(Transfer | Protocol, Transfer | Notification, and Transfer | Schedule) before you can enable the 
profile. 

 

Auditing and Validating the Imported Profiles 

After you import a profile, you must audit and validate it to verify its integrity. 

To audit a profile: 

1. Select the profile that was imported in the previous section. 

2. Choose Profile | Audit. The audit function reviews the profile and compares all Agile mapped 
fields to designated target system tables. Most newly imported profiles fail the audit and return 
an Error Log dialog box, as in the following figure. This is normal. 

Equation 7: -1: Audit errors 

 
3. To pass the audit, the profile must go through a validation step with the Edit Mapping function. 

Click OK to close the Error Log, and proceed to the next step. 

4. Choose Mapping | Edit Mapping. The Field Mappings window appears and displays all Agile to 
target system field mappings for the selected profile. 
 If the Field Mappings dialog box appears with no errors or alert prompts, give the 

mappings a cursory review and click OK. Clicking OK validates the mappings. Proceed to 
Step 4, below. 

 If your profile contains conditional mappings, you may receive the following messages 
before the Field Mappings dialog box appears. This is normal. 

The Mapping Analysis message states, which mapped line number, needs to undergo an 
additional validation step. Note the mapping number and click OK. 
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The Conditional Mappings message follows, stating that some target system tables are not 
mapped properly to related Agile tables. Click OK to continue. 

5. When the Field Mappings dialog box appears, in the Mapped Fields pane, select the mapping 
line number that was displays in the Mapping Analysis message earlier, and click the Edit 
Mapping button. The Map Condition dialog box appears. 

6. No information changes are required. Click OK. The Agile Table Type dialog box appears. No 
information changes are required.   

  
7. Click OK. The condition goes through an automated system validation. At this point, you should 

return to the Field Mappings dialog box.  

8. Click OK to close the dialog box and proceed to the next step. 

9. You can now re-audit the profile. Choose Profile | Audit. The Audit function reviews the profile 
and confirms that the profile is responding normally and that all mapped tables are valid. If they 
are, you should receive the following message: 

Equation 8: -3: Agile Table Type dialog box 

 
If the audit returns no errors, your profiles are in good shape. If you receive additional audit 
errors, perform Steps 2 through 6 again until all conditional rows are validated. 

If you continue to receive errors, contact Agile Support. 

Copying Profiles 

You can create a new profile by copying one that already exists in your profile library. The copy 
contains the Format settings and Mappings of the original profile. The user needs to enter name 
and Transfer settings. 
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To copy a profile: 

1. Choose Copy from Profile menu. 

The Copy Profile dialog box appears. 

2. Use the list to select a source profile from your profile library. The current profile appears by 
default. 

3. Enter a new name for the selected profile. The currently profile name appears by default. 

4. Enter a new description or edit the current description. The description of the current profile 
appears by default. 

5. Click OK to add a profile with the new name and description. 

6. Check imported profile names for uniqueness. If you find a duplicate in the profile library, the 
system prompts you to enter a new name or to skip that profile.  

 

Renaming Profiles 

You can rename the current profile or change the profile description. 

To rename a profile: 

1. Either select a profile in the Profile Library table of the ChangeCAST window and choose 
Rename from the Profile menu, or double-click a profile in the Profile Library table. 

The Rename Profile dialog box opens with the selected profile loaded. 

2. Enter a new name for the profile. The name of the profile appears by default. 

3. Enter a new description, or edit the current description. The description of the profile appears 
by default. 

4. Click OK to apply the new name and description to the profile. 

5. Check imported profile names for uniqueness. If you find a duplicate in the profile library, the 
system prompts you to enter a new name or to skip that profile. 

 

Removing Profiles 

If necessary, you can also remove a profile from the profile library. 

To remove a profile: 

1. Select a profile in the Profile Library table of the ChangeCAST window and choose Remove 
from the Profile menu. 

2. The system prompts you to remove the profile or cancel the operation. 

3. Click OK to remove the selected profile. 

Note   Deleting a profile clears transfer flags, a process that takes time. It is very important that 
you wait while ChangeCAST completes this process. 
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Using Profiles 
Before you can use a profile, you need to: 

  Set up its Attributes table. 

  Complete a set of Agile-to-target system field mappings. 

  Enter transfer destination and schedule information. 

  Set up a list of users to notify in case of transfer problems. 

For instructions, see Defining Attributes and Mapping Fields on page 19 and Formatting and 
Transferring Data Files on page 35. 

Distributing Profile Libraries 
Sometimes it is appropriate to create a profile library on one computer and distribute it to 
ChangeCAST users working at other sites. ChangeCAST always uses ChangeCAST.agx as the 
active profile library. 

To distribute a profile library: 

1. Exit Agile ChangeCAST completely (Do not minimize). 

2. Copy the profile library (ChangeCAST.agx) you want to distribute and give it another name, 
such as NewLibrary.agx. 

3. Distribute it to the target ChangeCAST site or sites. 

When it reaches the target site, you should: 
 Copy it to a temporary folder such as c:\temp, to make sure that you do not overwrite a 

ChangeCAST file. 
 Before you import the new profiles, decide whether to replace the current version of 

ChangeCAST.agx with the new profile library, or import profiles from the new profile library 
into the existing profile library. 

 After deciding what to do with the profile library, follow the instructions for Importing a 
Profile on page 14. 

 Verify Transfer settings. 
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Chapter 3 

Defining Attributes and Mapping Fields 

This chapter includes the following: 

 Guidelines for Defining Attributes and Field Mappings........................................................................................ 19 
 Differentiating Documents from Parts and MCOs from ECOs............................................................................. 20 
 Defining Target System Attributes ....................................................................................................................... 20 
 Specifying and Verifying Agile-to-Target System Field Mappings ....................................................................... 24 
 Producing ChangeCAST Reports........................................................................................................................ 31 

Before you can use a profile to transfer Agile data, you must map fields in the Agile database to 
fields in the target system. 
 

Guidelines for Defining Attributes and Field Mappings 
To define target system attributes and field mappings for each profile in your ChangeCAST profile 
library, follow these basic steps: 

1. Select a profile in the Profile Library table of the ChangeCAST window. For details, see The 
ChangeCAST Window on page 4. 

2. Decide whether you want ChangeCAST to distinguish documents from parts, and MCOs from 
ECOs. For details, see Differentiating Documents from Parts and MCOs from ECOs on page 
20. 

3. Define target system attributes to identify the fields in the target or host target system that could 
be chosen to receive data from the Agile system. 

4. Print Agile Table and Attributes reports to assist in mapping Agile fields to fields in the target 
system. For details, see Defining Target System Attributes on page 20. 

5. Use the Agile fields and target system attributes to create a set of Agile-to-target system field 
mappings. For more details, see Guidelines for Mapping fields on page 24. 

6. Print a Mappings report to verify that the mappings are correct. For details, see Profile Reports 
on page 32. 

Note  Even if you obtain a profile library from another source, you need to verify that its 
mappings and settings are correct. 

7. Modify the mappings as necessary until they are correct. 

Once you create the mappings, you can define transfer settings and start using ChangeCAST. 

Note   While working with attributes and mappings, it is a good idea to use a temp directory to 
hold attribute and other files that you have exported or intend to import or open. Be 
careful not to overwrite files in the top-level ChangeCAST program directory, especially 
ChangeCAST.agx. 
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Differentiating Documents from Parts and MCOs from 
ECOs 
By default, ChangeCAST treats documents as parts, and MCOs as ECOs. Therefore, the system 
maps documents and parts, and MCOs / ECOs to the same target system table. If you want 
ChangeCAST to distinguish documents from parts, and MCOs from ECOs, use the Enable 
differentiation between Agile Classes setting (in the Options dialog box). With this setting, you can map 
documents separately from parts, and you can map MCOs separately from ECOs. 

Note  If you are upgrading from a prior release of ChangeCAST, before you can use Enable 
differentiation between Agile Classes, you must create new target system tables and 
attributes, and re-map documents and MCOs. In addition, you may require modifications, 
if you are using an application adapter, to support this mode. 

To access the Enable differentiation between Agile Classes option: 

1. Choose Edit | Options. 

2. Check the Enable differentiation between Agile Classes box. 

3. Click OK. 

If you do not check this option, ChangeCAST treats documents as parts and MCOs as ECOs. This 
reflects the behavior in previous releases of ChangeCAST. 

Defining Target System Attributes 
Before you can complete a ChangeCAST profile definition, you need to define attributes for the 
target system database. These describe the database fields of the target system that you can map 
to receive data from Agile. 

You can use the Attributes Table dialog box to define attributes for the target system by entering 
them manually or by opening or importing a ChangeCAST (*.aga) attribute file. For details, see The 
Attributes Table Dialog Box on page 20. 

After you define a set of attributes, you can print and review an Attributes report. Modify the attribute 
definitions if necessary. 

Note  We recommend that you include all of the fields available for the target system. This 
makes it easier to add mappings that you did not use in the initial ChangeCAST 
implementation. 

The Attributes Table Dialog Box 

To display the Attributes Table dialog box: 

1. Select a profile in the Profile Library table and choose Edit Attributes from the Mapping menu. 

2. You can edit, view, or create new attributes individually with the text boxes at the top of the 
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Attributes Table dialog box. 
Equation 9: -1: Attributes Table dialog box 

 
 

Attribute Text Boxes 

The following fields appear for the row selected in the table at the bottom of the dialog box. 

Field  Descr ipt ion 

Table Name Name of the target system table containing the target system field that may be 
targeted to receive data. 

Table Description Descriptive text used to define the target system Table name. 

Field Name Name of the target field in the target system table. 

Field Description Descriptive text used to define the field name. 

Field Length The maximum length (characters) allowed for data sent to the target system field. 

Field Type The type of data: numeric, date, or text. 

 
 

The Attributes Table 

The Attributes table, in the lower part of the dialog box, contains target system table names, table 
descriptions, field names, field descriptions, and field lengths for the loaded target system attributes. 

The Attributes table must exist before you can map Agile fields to the target system. After loading or 
directly defining these target attributes, you can use the Field Mappings dialog box to configure the 
actual Agile-to-target system field mappings. 
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You can load attributes from an exported ChangeCAST attribute file (*.aga). 

Attributes Table Dialog Box Buttons 

The following buttons act on the Attributes table: 

Button  Act ion  

Add Adds data in the attribute text boxes to the Attributes table as a new row. 

Modify Replaces selected row with edited data from the attribute text boxes. 

Remove Deletes the selected row. 

Import Replaces all existing attributes with the contents of the selected attribute file (*.aga). 

Export Saves current Attribute table rows as an attribute file (*.aga). 

Add from file Adds attributes in the selected attribute file (*.aga) to the list of existing attributes. 

 
 

Adding Individual Attributes 

To create an attribute directly in the Attributes Table dialog box: 

1. Enter attribute data in the text boxes. 

2. Click Add to add the new attribute to Attributes table. 

Note  The Add button is available only if the table name/field name combination you enter is 
different from all others in the Attributes table. You can add attributes, if you change the 
table name or field name. You can modify the attribute, if you change the table 
description or field description. 

 

Modifying Attributes 

To modify an existing attribute in the Attributes Table dialog box: 

1. Select an attribute in the Attributes table. 

Its fields appear in the text boxes at the top of the Attributes Table dialog box. 

2. Edit attribute data in the text boxes. 

3. Click Modify to enter changes in the Attributes table. 

Note  You cannot modify an attribute’s target system table or attribute name if a mapping is 
currently using the attribute. You can modify the descriptions and field length. 
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Removing Attributes 

To remove an attribute in the Attributes Table dialog box: 

1. Select an attribute in the Attributes table. 

2. Click Remove to delete attribute from the table. 

Note  You cannot remove an attribute if a mapping is currently using it. 
 

Appending Attributes from a File 

To append attributes from an attribute file to the bottom of the current Attributes table in the Attributes Table 
dialog box: 

1. Click Add from file in the Attributes Table dialog box. 

2. Select the attribute file (*.aga) that contains the attributes you want to add. 

3. Click Open. 

The attributes in the selected file appear following those in the current table. 

Importing Attributes 

To select a new attribute file (*.aga) and replace all existing attributes in the Attributes Table dialog box: 

1. Click Import in Attributes Table dialog box. 

2. Choose an attribute file to import and click Open. 

Note  When you import an attribute file and replace all existing attributes, you also reset and 
remove all existing mappings for the profile. 

 

Exporting Attributes 

You can export all of the attributes in the current Attributes table to an .aga text file. 

It is not necessary to export attributes, since the attribute information contained in the table is 
included in the current profile. However, you can use export .aga files for reference, and request 
your Agile Support representative to help with troubleshooting. You can copy these files to other 
Agile servers and use them as source files for importing ChangeCAST attribute sets. 

To export attributes in the Attributes Table dialog box: 

1. Click Export. 
2. Specify the name and location of the ChangeCAST attribute file (*.aga). 

3. Click Save. 
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Verifying Attributes 

When you have finished loading or entering field attributes, you can verify if all necessary target 
system fields are included in the Attributes table and their entry is correct. 

To verify attribute definitions, print and review an Attributes report. 

When the attribute data is complete, you can map Agile fields to the target system fields. 

Specifying and Verifying Agile-to-Target System Field 
Mappings 
ChangeCAST profiles contain mappings of fields in your Agile database to corresponding fields in a 
target system. ChangeCAST uses these mappings when it creates files that transfer information 
from an Agile database to a target system database. 

Guidelines for Mapping Fields 

To create, modify, and verify field mappings in ChangeCAST, follow these basic steps: 

1. Before you begin to map Agile database fields to fields in the target system, ensure to complete 
the following tasks: 
 Produce a report of Agile data tables and fields. For more details, see Producing an Agile 

Tables Report on page 32. 
 Complete entry target system attribute for each profile. For more details, see Defining 

Target System Attributes on page 20. 
 Produce an Attributes report for each profile. For more details, see Profile Reports on page 

32. 
 Open the ChangeCAST Field Mappings dialog box and use it to map Agile fields to 

equivalent target system fields. 

2. Produce a Mappings report and use it to verify the mappings. For details, see Managing 
Mapped Fields on page 31. 

3. Modify any incorrect mappings in ChangeCAST and produce additional Mappings reports until 
the mappings are complete. 

Note  If you are using profiles created by others, perform steps 2 and 3 to verify that the 
mappings are complete and correct. 

 The underscore character (_) will replace invalid characters within a target 
system table or target system field name unless you substitute the invalid 
character with a valid one. The invalid characters are a left parentheses ( ( ), a 
right parentheses ( ) ), an asterisk ( * ), and a period ( . ). 
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Mapping Manufacturer or AML Fields 

The following considerations apply if you are mapping fields from Agile Parts: 

 Ensure the fields are set to Visible in Agile Administrator, in the Manufacturer or Manufacturer Part 
| Attributes node, and in the Parts Class | Attributes | Manufacturer node. 

 Map all Agile Manufacturer fields to a single target system table, separate from other BOM item 
data. 

 You cannot map the multi-list fields of Manufacturers and Manufacturer Parts (see Appendix C 
of the Agile ChangeCAST Developer Guide). 

 You cannot mix Pending changes in a single table with AML, and you cannot include BOM 
fields in the same table when you map AML fields. 

Note  You cannot map fields in the Page Three tab (an optional tab that your administrator may 
have set up). Ensure all fields that you must transfer are on Page Two or on other tabs, 
where you can map them. 

 

The Field Mappings Dialog Box 

You use the Field Mappings dialog box to create ChangeCAST field mappings. 

To display the Field Mappings dialog box: 

1. Select a profile in the ChangeCAST window. 

2. Choose Mapping | Edit Mappings, or click Edit Mapping on the ChangeCAST toolbar. 

(You can also choose Profile | Add to display the Add Profile dialog box, and then click the Field 
Mappings button in the Add Profile dialog box.) 

The Field Mappings dialog box contains: 

Tree or  Table  Descr ipt ion 

Agile Fields tree Appears in the upper left portion of the dialog box and lists available Agile data 
tables and fields, grouped by table names. An Agile field can be used in multiple 
mappings. The field’s ID number displays in parentheses. (The ID is what you use 
for the actual mapping by ChangeCAST.) 

Target System Fields 
tree

Appears in the upper right portion of the dialog box and lists all of the target system 
tables/fields configured in the Attributes Table dialog box. This tree hierarchy is 
grouped by table names in the target system. A target system field may be mapped 
only once. 

An asterisk in parentheses following a target system table name indicates that the 
target system table has attributes that are mapped to a field of an Agile table. 

An asterisk following a target system attribute indicates that the attribute is mapped 
to a field that belongs to an Agile table (for example, a BOM table). 

Mapped Fields table Appears in the lower portion of the dialog box; lists each target system field and 
what is mapped to it, displayed as a row in the table. Row order determines 
processing order, top to bottom. 
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Mapped Fields Table Columns 

The Mapped Fields table contains these columns: 

 The No. column, the leftmost column in the table, numbers each mapping. Each mapping 
occupies one row. The processing is from top to bottom, and the number in the No. column 
signifies the order. 

 The Target System Attribute column contains the target table and field. Individual target system 
fields group by target system table name in the Mapped Fields table. The order of the entries in 
the Mapped Fields table is a direct reflection of the resulting transfer file. 

Note  Mapping order is critical to the successful loading of data into the target system. For 
details, see Reordering Mapped Fields on page 31. 

 The Agile Attribute column contains the Agile field and/or Map Condition expression defining the 
value to be transmitted. 

 

Field Mappings Dialog Box Buttons 

The Import button lets you import mappings from .MAP files (text files), replacing all existing 
mappings. The Add button lets you add mappings from a mapping file. For details, see Importing or 
Adding Field Mappings on page 29. The buttons to the right side of the Mapped Fields table apply to 
the selected mapping. 

Button  Act ion  

Unmap Removes the selected mapping from the table. 

Move Up Moves the selected mapping up in the list within the appropriate table. 

Move Down Moves the selected mapping down in the list within the appropriate table. 

Edit Mapping Displays the Map Condition dialog box for the selected mapping. If no condition is 
configured, you can create a condition. If a condition already exists, you can edit the 
existing condition. 

Reorder Tables Displays a dialog box where you can specify the output order of the mapped tables. 

Note  Unmap removes the selected mapping row. There is no undo for this action! If you 
remove a mapping and want to retrieve it, recreate it with the mapping tools at the top of 
the dialog box, or click Cancel to close the Field Mapping dialog box and lose any 
modifications that you have made. 

Creating Field Mappings 

To map an Agile field to a target system field: 

1. Expand the source Agile Fields tree, and select the source Agile field. 

2. Expand Target Fields tree, and select the target system field. 
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3. Click the Map button.  

The mapping appears in the Mapped Fields table. 

ss to the system NULL character, map the field to 
t setting. 

nd select the target system field. 

n the 
umn in the Mapped Fields table as a placeholder for an Agile field or mapping 

 flags, such 

n about system variables. 

stem Fields tree, and select the target system field. 

m Flags list, select the flag to which you want to map the target system field. 

4. 

L 
u can assign an Agile table to the 

5.  mapping or mapping to null, 
tions to control a field’s mapping. 

 the 
ata or change the data sent from the Agile field mapped in the Field 

 the Table of Contents for online 
t of Contents topics. 

ree and select the target system field. 

Mapping to Null 

If you want to map a target system field to pa
NULL. This often conveys a defaul

To map a target system field to null: 

1. Expand Target Fields tree, a

2. Click the Map To Null button. 

When you map a field to null, the field lists in the Mapped Fields table. SYS_NULL appears i
Expression col
condition. 

Mapping to System Variables 

The Map Special button lets you map target system fields to system variables, or system
as SYS_ACD. This button is not available if you map the selected target system field. 

See, the Agile ChangeCAST Developer Guide for informatio

To map a target system field to a system variable: 

1. Expand Target Sy

2. Click Map Special. 
3. In the Syste

Click Map. 

If there is only one system flag and the table has not been set as a “BOM table” or as an “AM
table,” the Agile Table Type dialog box appears so that yo
target system table that contains the target system field.  

Select an Agile table from the list. Instead of setting up a simple
you can specify a set of condi

 

Specifying a Map Condition 

Map conditions are formulas that can examine and manipulate Agile field data and, based on
results, either use the d
Mappings dialog box. 

ChangeCAST macro functions construct Map conditions as explained in Agile ChangeCAST 
Developer Guide, and in Online Help. To view macro information in Online Help, choose Help from 
the ChangeCAST menu bar. Then, choose Help Contents to display
Help, and choose Macro Reference from the lis

To specify a map condition for a new mapping: 

1. Expand Target System Fields t
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2. 

ars. You can enter a formula for manipulating data, which 

d data using functions. For more information, see The Map Condition Dialog Box

Click the Map Condition button. 

The Map Condition dialog box appe
will be sent from the mapped field. 

For example, the formula =IF(ISBLANK([Parts.General Items Attributes.Rev:1014]),”Invalid”,”Valid”) 
returns Invalid if no revision has been supplied. You can also change the form of the 
transmitte  on 

3. se the Map Condition dialog box, the mapping appears in the Mapped Fields 

click the mapping row in the table or 
 the Edit Mapping button. 

page 28. 

When you clo
table. 

To edit a map condition for any existing mapping, double-
select the mapping row and click

The Map Condition Dialog Box 
Equation 10: -3: Map Condition dialog box 

 

The M ition dialog box includes these boxes, lists, and buttons: 

 

ap Cond

Name Act ion  

Target Field s the name of the target system table/field to which this condition will Display
apply. 

System Flags list 
T Macro Reference Help topics for explanations of the system 

Lets you select a system flag for use in the condition formula (refer to Agile 
ChangeCAS
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Name Act ion  
variables). 

Insert Flag button Inserts the selected system flag, or variable, into the Expression field. 

Agile Fields list Allows you to select an available Agile source field. 

Insert Field button Inserts the selected field name into the Expression field. 

Function List Allows you to select macro functions for use in the condition formula (refer to Ag
ChangeCAST Macro Reference Help topics for explanations of the functions and 

ile 

their syntax). 

Insert Function 
button 

Inserts the selected function (and placeholders) into the Expression field at the 
cursor location. 

Expression field nstruct the condition formula that will be used to calculate the value for 
t 

Used to co
the target field; contains the fields and functions that you insert with the Inser
Flag, Insert Field, and Insert Function buttons, including constants and system 
variables. 

Test Expression Expression field and generates a 
sample of the value returned by the condition formula. 
Checks the syntax of the statement in the 

button 

Test Result field Contains the result of running the test. 

 
 

Editing Condition Formulas 

You can edit the formula in the Expression field by inserting fields and functions at the cursor 
location. You can also cut (Ctrl+X), copy (Ctrl+C), and paste (Ctrl+V) selected text or type it directly

Conditions are verified when the profile is enabled, when you click 

. 

ou click the Test OK, or y
Expression button in the Map Condition dialog box. When you are done with all mappings, you can 
click the Audit button in the ChangeCAST toolbar to test for syntax errors. See Toolbar for an 
illustration of the Audit button. For details, see The Error Log on page 44. 

For more information about conditional field mappings, click Help in the Map Condition dialog box or 
choose Help | Contents from the ChangeCAST menu bar, and then choose Macro Reference on the 
Help Contents tab. The Agile ChangeCAST Developer Guide contains examples to help you set up 
and debug conditions. 
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Importing or Adding Field Mappings 

You can import and add field mappings from mapping (.MAP) files generated with ChangeCAST 8.1 
or later systems. 

Sample .MAP file 
Equation 11: -4: Sample .MAP file 

 

The Import button imports field mappings, replacing all existing mappings. The Add button imports 
field mappings, adding the imported mappings to the existing mappings. 

To import field mappings in the Field Mappings dialog box, replacing any existing mappings: 

1. Click the Import button. ChangeCAST warns you that it will replace existing mappings. 

2. Click Yes to continue with the operation. The Open dialog box appears. 

3. Locate the .map file you want to import and click Open.  

The mappings appear in the Mapped Fields table. 

To add field mappings in the Field Mappings dialog box: 

1. Click the Add button. The Open dialog box appears. 

2. Locate the .map file that contains the mappings you want to add, and click Open.  

The mappings appear in the Mapped Fields table after any existing mappings. 

Note  If there are conflicts (for example, one target system field is mapped to more than one 
Agile field), an error message appears, an entry is written in the Error log, and the 
offending fields are mapped to the SYS_NULL system variable. See Appendix A of the 
Agile ChangeCAST Developer Guide for more on the available macro functions and 
system variables. 
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Managing Mapped Fields 

The Mapped Fields table, in the lower portion of the Field Mappings dialog box, lists existing Agile-
to-target system field mappings. 

If you select a mapping row in the table, you can use the buttons on the right side of the Mapped 
Fields table to manipulate the mapping. For a description of the buttons, see Field Mappings Dialog 
Box Buttons on page 26. 

Exporting Field Mappings 

You can export field mappings to use with other ChangeCAST profiles. 

To export field mappings: 

1. In the ChangeCAST window, select a profile that contains the mappings that you want to 
export. 

2. Choose Mapping | Edit Mappings. 

3. Click the Export button. The Save As dialog box opens. 

4. Specify a filename and location for the mapping file. The file will have a .MAP extension. 

5. Click the Save button. 

You can now import the saved file into other ChangeCAST profiles. 

Reordering Mapped Fields 

Mapped fields are processed and output from top to bottom, according to their row position appears 
in the Mapped Fields table on the Field Mappings dialog box. You can group fields by their target 
system table name. 

To adjust the processing order of mapped fields at the table level: 

1. Click the Reorder Tables button on the Field Mappings dialog box. 

2. Select a table and click Move Up or Move Down to change the position of the table. 

3. When you are done, click OK. 

To reorder field mappings directly: 

1. Select the mapping in the Mapped Fields table. 

2. Use the Move Up or Move Down buttons to change the position of the field within the same table 
list. 

3. When you are done, click OK. 
 

v9.3 31

  



ChangeCAST User Guide  

 

 

Producing ChangeCAST Reports 
ChangeCAST Profile reports can help you verify attribute definitions, mappings, and other profile 
settings. The Agile Tables report lists Agile tables and fields, so you can match them with 
appropriate fields in target system tables. 

Profile Reports 

You can produce several kinds of reports for the profile currently selected in the ChangeCAST 
window or for all profiles in the profile library. 

To produce a ChangeCAST Profile report: 

1. Open the Reports menu. 

2. Choose Current Profile to prepare a report for the selected profile, or choose All Profiles to 
prepare a report for all profiles in the library. 

3. Choose the type of report: 
 Attributes to list current target system field attributes 
 Mappings to list current Agile-to-target system field mappings 
 Settings to list current transfer file format settings 
 Transfer Options to list target destination and communication settings 

A Save As dialog box appears and prompts you to save the report as a text file with extension 
.txt. 

4. Specify a destination for the report, and enter a name. 

5. Click Save to save the report to the specified destination and display its contents in Windows 
Notepad. 

 

Producing an Agile Tables Report 

You can produce a list of Agile data tables and their fields to help you map Agile data fields to fields 
in the target system database. 

To produce an Agile Tables report: 

1. Choose Reports | Agile Tables. 

A Save As dialog box appears and prompts you to save the report as a text file with extension 
.txt. 

2. Specify a destination for the report, and accept the default name or enter a different name. 

3. Click Save to save the report to the specified destination and display its contents in Windows 
Notepad. 

 

Printing ChangeCAST Reports 

To print a ChangeCAST report saved as a text file, open it in Notepad, WordPad, or another text 
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editor or word processor outside of ChangeCAST and print it from there. You can then use the 
report to help you change or verify ChangeCAST settings. 
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Chapter 4 

Formatting and Transferring Data Files 

This chapter includes the following: 

 Formatting ChangeCAST Transfer Files ............................................................................................................. 35 
 Reviewing and Modifying Transfer Settings ........................................................................................................ 36 
 Enabling and Disabling Profiles ........................................................................................................................... 42 
 Starting and Stopping ChangeCAST ................................................................................................................... 43 
 Viewing and Printing Log Files ............................................................................................................................ 43 
 Retransferring Change Orders ............................................................................................................................ 45 
 Backing Up Files.................................................................................................................................................. 45 
 Suggestions for Troubleshooting ......................................................................................................................... 46 

The following sections introduce ChangeCAST transfer files and describe how to specify the 
source, destination, and polling schedule for transfer files. 
 

Formatting ChangeCAST Transfer Files 
Transfer files are ASCII text files that relay information from Agile to a target system. Their default 
extension is .agl. They can have many format variations, depending on what the application adapter 
requires to verify and load information into the target system database. 

Note  This information is only an overview. Unless you are involved in creating transfer files to 
suit specific application adapters, you should not change any transfer file format settings. 
Incorrect settings can result in transfer files that are not readable by the target system. 

To set the format of ChangeCAST transfer files: 

1. Select a profile in the Profile Library table in the upper half of the ChangeCAST window. 

2. Choose a command from the Format menu, depending on the type of settings you want to 
review or modify: 
 File Structure — Basic elements of the file structure, such as data/layout sections and 

orientation (horizontal or vertical) 
 Delimiters — Whether fields are delimited or fixed length, and which characters to use as 

delimiters 
 Data Format — Format options for reference designators, time and date formats, text data 

conversions 
 BOM/AML Settings — Options for how BOM rows are output 

3. In the File Format dialog box, change appropriate settings and apply them. 

4. Produce and print a Settings report so you can verify the settings and change them if 
necessary. See Profile Reports on page 32. 

For specific information, see the ChangeCAST online Help and the Agile ChangeCAST Developer 
Guide. 
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Reviewing and Modifying Transfer Settings 
You can use the ChangeCAST Transfer menu and Transfer Options dialog box to review and 
change a number of settings related to data transfer: 

 Protocol — Transfers files (FTP or local copy) with appropriate destination settings 

 Notification — Whom to notify through e-mail in case of transfer problems 

 Schedule — When and how often to poll for change order releases and perform transfers 

 Files — Transfer file naming conventions and other transfer file details 

 Application Adapter — Starts a local application adapter (not available if files are FTP’d to 
another location). 

 ChangeCAST Monitor — Restarts data transfer automatically if the ChangeCAST service crashes 
during transfer of large volume of data 

Note  You are most likely to change the Protocol, Notification, and Schedule settings. Only 
those who are closely involved in implementing ChangeCAST and related application 
adapters should need to change the Files and Application Adapter settings; as with 
Format settings, incorrect Files and Application Adapters settings can result in serious 
transfer problems. 

The following sections describe how to review Protocol, Notification, and Schedule settings and 
change them if necessary. For details on Files and Application Adapter settings, see ChangeCAST 
Online Help and the Agile ChangeCAST Developer Guide. 

Configuring ChangeCAST Monitor 

The ChangeCAST Monitor tool restarts the ChangeCAST service automatically if it crashes during 
large volu en: me data transfer. The monitor restarts automatically wh

 d exceeds 500: The recommended value of changes 

 
per limit that is set (1000MB). You can specify the upper limit within the CC 

 ChangeCAST loses connection with the Agile server. 

  > Agile > 9.3 > ChangeCAST Monitor or click the ChangeCAST Monitor shortcut on your 

 
server. 

The total count of the change orders transferre
that you can transfer per session is 200. 

The memory size of ChangeCAST process exceeds 1000MB: If the ChangeCAST memory usage is 
higher than the up
Monitor window. 

To launch and run ChangeCAST monitor: 

Go to Start
Desktop. 

Enter the following details in the blank fields. 
 User: “administrator”. The username with which you log in to Agile 
 Password: “Agile”. The password you use to log in to Agile server. 
 Memory Size: The maximum memory usage or VM size of the ChangeCAST process 
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(between 200~1000MB). The recommended value is 700MB. 
r of changes transferred in one ChangeCAST session (between 

eCAST service status. 

 to disable the CC Monitor. 

s it in the CC Monitor.log file within the 
same folder. 

ly. 

 No. of Changes: The numbe
5~500). The recommended value is 200. 

 Click Save to save the details. 

 Click Refresh to check the Agile Chang

 Click Start to enable the CC Monitor. 

 Click Stop

The Monitor Log logs in all the actions you perform and save

Note  You can only uninstall the CC Monitor manual
 

col 
rious FTP options. 

 
 rror is sent to the 

Notification status is Disabled. The file does not 
t time a transfer occurs; either on schedule or with 

ing: 

 Select a profile in the ChangeCAST window and choose Protocol from the Transfer menu. 

 Use the Transfer Options toolbar button. 

Reviewing and Editing Protocol Settings 

You can use the Protocol tab of the Transfer Options dialog box to configure file transfer proto
options, including whether to use FTP (File Transfer Protocol) and va

If you check the Use FTP check box, the numbered files in the outgoing directory transmits in 
numerical order to the FTP target path specified on the Protocol tab. 

If the FTP process is successful, the file transfers but a copy remains in the outgoing directory. 

If the FTP process is not successful, an email indicating that there was an e
addresses listed on the  tab, and the profile 
transfer. If you re-enabled the profile, the nex
the Transfer Now button or command, it generates and transfers a new file. 

To display the Protocol tab, do one of the follow
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ChangeCAST Protocol settings 

Equation 12: -1: ChangeCAST Protocol settings 

 

You can review the Protocol settings listed in the above table and change them if necessary. 

Important Specify the FTP transfer target path as a relative path. Drive letters or literal paths are 
not accepted. 

Protocol options 

Set t ing  Act ion  

Output Directory The local directory in which all transfer files are created and archived (whether 
using FTP or not) for this profile. 

Use Default Output 
Directory For All 
Profiles

When checked, applies the same Output Directory information to all profiles; if 
not checked, settings apply only to the currently selected profile. 

Currently Using Default 
Directory From Profile

The name of the profile that is currently using this default directory. Available 
only if Use Default Output Directory For All Profiles is checked. 
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Set current profile as 
default

Sets the output directory of the currently selected profile as the default for all 
profiles. Available only if Use Default Output Directory For All Profiles is 
checked. 

Use FTP When checked, transfers data using FTP. 

FTP Host Name The IP address or DNS NAME (host alias) of the host system. 

FTP User Name Your FTP host login name. 

FTP Password Your FTP host password. 

Confirm Password A second entry of what you typed for FTP Password; the password entered 
must be exactly the same as the one entered previously, both the spelling and 
case. 

FTP Target Path The destination directory where files can be accessed by the application 
adapter for the host target system (if UNIX host, must use “/” as appears on 
target server). You can enter a dot ( . ) to specify the current path. 

Important: The FTP transfer target path must be specified as a relative path. 
Drive letters or literal paths are not accepted. 

FTP Port The host system FTP port (Port 21 is the default). 

Transfer Mode The FTP transfer mode, either Binary or ASCII; use the default, ASCII. 

Verify FTP Connection Tests the FTP parameters you entered by relaying a dummy file to the target 
then deleting it; if there are any problems contacting the FTP Host, an error 
message appears. 

 
 

Reviewing and Editing Notification Settings 

You can use the Notification tab of the Transfer Options dialog box to set up a list of users to notify 
by e-mail in case of processing or transfer errors. ChangeCAST does not detect failures of 
application adapters to process a transfer file once you deliver it. Notification can be different for 
each profile and you need to define it for each profile. 

To display the Notification tab, do one of the following: 

 Select a profile in the ChangeCAST window and choose Notification from the Transfer menu. 

 Use the Transfer Options toolbar button. 

You can review the following Notification settings and change them if necessary: 

List  Act ion  

All Users Lists eligible users, obtain list from Agile Administrator; restart ChangeCAST to update 
the list. 

Users To Notify Users selected to receive an email in the event of an error; if none are listed, no one is 
notified. 
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ChangeCAST Notification settings 
Equation 13: -2: ChangeCAST Notification settings 

 

You can: 

 Use >> to move the selected user from the All Users list to the Users To Notify list. 

 Use << to remove the selected user from the User To Notify list and add it back to the All Users 
list. 

 Use Shift+click or Ctrl+click to select more than one user. 

Note  If you add Users to Agile Administrator while ChangeCAST is running, on restarting 
ChangeCAST you discover new users. 

 

Reviewing and Editing Schedule Settings 

You can use the Schedule tab of the Transfer Options dialog box to specify how often to poll the 
Agile database and transfer released change orders. 

To display the Schedule tab, do one of the following: 

 Select a profile in the ChangeCAST window and choose Schedule from the Transfer menu. 
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 Use the Transfer Options toolbar button. 
Equation 14: -3: ChangeCAST Schedule settings 

 

 

You can review the following Schedule settings and change them if necessary: 

Set t ing  Act ion  

Use Same Schedule 
For All Profiles

If checked, uses the same schedule for all profiles; if not checked, the current 
Schedule settings apply only to the selected profile. 

Once A Day Automatically runs the transfer once a day at the designated start time. The 
default is once a day. 

Every x Hours y 
Minutes

The default; specifies the time interval between transfers, calculated from the 
Starting At time: 
 If previous transfer processing is not finished, the next transfer does not 

begin until the next scheduled time arrives. 
 The minimum time is 0 hours, 5 minutes; the maximum time for each field is 

11 hours and 59 minutes. 
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 The default is 1 hour, 0 minutes. 

Starting At Specifies an absolute time to start checking for released change orders: 
 This option must be set. 
 The default starting time is 8:00 AM. 

Ending At Specifies an absolute time to stop checking for released change orders, for 
example, to stop the schedule for regular backups or maintenance: 
 The default time is 5:00 PM. 

Days Specifies the days to process change orders according to the hourly schedule; 
Monday through Friday are selected by default. 

The ChangeCAST Service uses the Starting At and Ending At times to determine whether to 
process change orders: 

 If you click the Resume button, and the current time is between the End and Start times (down 
time), the system will not process change orders until it reaches the Start time. 

 If you click, the Pause button, then Agile ChangeCAST Service stops, regardless of the 
schedule until it is started (Resumed). 

 For multiple profiles processing, processing proceeds profile by profile. 

Note  You can use the Transfer Now command to override schedule settings and force 
ChangeCAST to poll for change orders. For details, see Forcing Unscheduled Transfers 
on page 45. 

 

Enabling and Disabling Profiles 
By default, new profiles are disabled. You can enable it, when you create, import, and verify all 
settings of a profile. 

To enable a profile: 

1. Select a profile from the Profile Library table in the upper part of the ChangeCAST window. 

2. Click the Enable button. The Transfer ECOs dialog box appears. 

3. Choose Transfer ECOs released prior to profile change(s) to transfer all change orders with transfer 
flags set to Not Transferred. Choose Transfer ECOs from this point forward to ignore all change 
orders released before the profile was enabled. 

4. Click OK. 

If settings are valid, the profile is Enabled. Otherwise, an error message appears, an entry 
appears in the Error log, and the profile remains Disabled.

5. To disable a profile, select a profile and click Disable. 

Note  If an FTP transfer fails, ChangeCAST automatically disables the profile and sends an 
email notification to all users listed in the Notification dialog box. You can check The 
Transfer Log on page 44 for details, fix the error, and enable the profile again. 
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Starting and Stopping ChangeCAST 
When you configure ChangeCAST properly, you can click Resume to start it. 

Note  For information about launching ChangeCAST and opening the ChangeCAST window, 
see Starting ChangeCAST on page 10. 

After you start ChangeCAST, it runs as a service. It polls the Agile database for newly released 
change orders or MCOs at the scheduled polling interval. 

You can minimize the ChangeCAST window by clicking the Minimize  button in the upper right 
corner of the window. To restore it to its original size, click the ChangeCAST icon in the Windows 
system tray. 

If ChangeCAST finds a released change order or MCO, it does the following: 

 Uses all enabled profiles to create ASCII transfer files that describe the change order. 

 Relays the transfer files to a specified location - either a local drive or, using FTP, to a host 
target system. At this point, a target system-specific application adapter can load the 
information into the target system tables. 

To stop ChangeCAST polling, click the Pause button. Polling for released change orders or MCOs 
stops and does not begin again until you click the Resume button. 

Viewing and Printing Log Files 
As ChangeCAST runs, its activities register in log files, so you can check a variety of information 
about how ChangeCAST is working: 

 TransferLog.txt, the Transfer log, documents the generation of transfer files plus transfer 
attempts and successes. 

 ErrorLog.txt, the Error log, documents condition syntax errors, and other error conditions that 
do not relate to transfer files or transfer attempts. 

The log files appear in Windows Notepad. You can search and perform other activities available 
through the Notepad menus. 

To print a log file: 

1. Choose Start | Programs | Accessories | Notepad (or WordPad) to open a text editor. 

2. Open a ChangeCAST log file (*.log) from the directory where ChangeCAST is installed (by 
default, c:\Agile\Agile 9.3\ChangeCAST).  

3. Choose File | Print to print the file. 

Note  When you open a log file outside of ChangeCAST, you can print it as usual, but text 
editors are not able to print when ChangeCAST launches them automatically. 

 

v9.3 43

  



ChangeCAST User Guide  

 

 

The Transfer Log 

The ChangeCAST Transfer log file (TransferLog.txt) shows if files have been sent to the specified 
destination and if their transfer was successful. The Transfer log accumulates information; when 
you open it, you see everything that occurred since you installed ChangeCAST or since a 
ChangeCAST user cleared the Transfer Log (with View | Clear Transfer Log). The last few lines of the 
Transfer log for the selected profile appear in the Transfer Log table of the ChangeCAST window. 

To view the Transfer log, do one of the following: 

 Click the View Log toolbar button. 

 Click View Log in the ChangeCAST window. 

 Choose Transfer Log from the View menu. 

To delete existing information in the Transfer log  

 Choose Clear Transfer Log from the View menu.The system prompts you to archive the log.  

 If you choose Yes, the Save As dialog appears, allowing you to save the current log, clearing 
the existing log. 

  If you select Cancel, the system clears the existing log without archiving it. 

Note  If you clear the log without archiving it, the information is not recoverable. It is good 
practice to save archives and name them with the date of the archive as a backup 
procedure. 

 

The Error Log 

The ChangeCAST error log (ErrorLog.txt) lists errors resulting from audits that do not relate to file 
transfers. For example, it includes syntax expression errors in mapping conditions. 

The Error log contains a date/time stamp followed by a narrative description of the error. 

To view the Er

Choose  from the  menu. 

 , the Save As dialog appears, allowing you to save the current log, clearing 

 If you select Cancel, the system clears the existing log without archiving it. 

Note  d 

ror log:  

 Error Log View

To delete existing information from the Error log: 

 Choose Clear Error Log from the View menu. The system prompts you to archive the log.  

If you choose Yes
the existing log. 

If you clear the log without archiving it, the information is not recoverable. It is a goo
practice to save archives and name them with the date of the archive as a backup 
procedure. 
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Retransferring Change Orders 
By default, ChangeCAST transfers data from all released change orders or MCOs, along with their 
Affected Items, AMLs, and BOMs, to a target system. Once you transfer data from a change order, 
the change order’s transfer flag is set to “Transferred” to notify ChangeCAST to skip the change 
order the next time it polls the database. You can set the transfer flag manually so ChangeCAST 
ignores specific change orders, or retransfers specific change orders. 

To change a transfer flag setting: 

1. Choose Set Transfer Flags from the Transfer menu. 

2. When the Set Transferred Flag dialog box appears, enter a search condition using the fields at 
the top of the dialog box, and choose Search. 

3. Select one or more change orders from the list (which includes all change orders with Released 
or Complete Status Type that match the search condition). 

You can use the Select All and Deselect All buttons. 

4. Select the appropriate Set Transferred Flag radio button. 

5. Select Transferred to stop all selected change orders from being sent to the target system, or 
select Not Transferred to allow selected change orders to be sent to the target system the next 
time ChangeCAST polls the Agile database. 

6. Click Apply to use the selected setting. 
 

Forcing Unscheduled Transfers 

Usually, you perform transfers according to the schedule defined on the Schedule tab. If appropriate, 
you can force ChangeCAST to look for newly released change orders or MCOs and untransferred 
change orders and MCOs immediately, without waiting for the next polling time. 

To force a transfer:  

 Choose Transfer Now from the Transfer menu, or click the Transfer Now button in the 
ChangeCAST window.  

This command is available whether the connection state is Paused or Resumed. 

Backing Up Files 
Once you install ChangeCAST and find that it is operational on your server, there are several files 
and folders within the ChangeCAST directory that you need to back up regularly. These files and 
folders contain all transfer histories, error histories, output histories, and target system profiles. If 
there is a server problem, you will be able to recover them quickly if you have backups. 

Folders: 

 Archive 

 Queue 
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Files: 

 ChangeCAST.agx — contains all available maps of target system profiles 

 ErrorLog.txt — contains all errors logged by each profile 

 Service.txt — contains a list of all profile transaction histories 

 TransferLog.txt — contains the full transfer history for each active profile 

ChangeCAST updates each of the files and folders listed above daily and automatically. If a 
ChangeCAST problem occurs, Agile Support may ask for copies of these files for review. Agile 
administrators should become familiar with these files and folders and know how to access and 
read them. 

Note  If your company backs up the Oracle Database and Agile iFS directories on a daily 
basis, ensure to include these files. 

 

Suggestions for Troubleshooting 
Here are a few guidelines on error recovery and troubleshooting in case a transfer failure or other 
errors occur. 

Error Recovery 

If a transfer fails, create a corrected change order and release it in Agile. ChangeCAST will process 
the new information and send it to the application adapter. If not, it corrects all errors in the change 
order, and the application adapter stops again, requiring a second correction, and so on. 

Check the Error log, which lists the errors, and the Transfer log, to find out if the transfers were 
successful.  If the application adapter for the target system has a log file, check it as well. For more 
details on other ways to trace the source of an error, see Troubleshooting on page 46. 

Troubleshooting 

Determine the root cause of a change order in a systematic way. You will need to compare old Agile 
part and BOM configurations with current part and BOM configuration in the target system and the 
transfer file. Because each of these components is a key factor in the successful transfer of data 
from Agile to the target system, consider each one when the processing of a change order fails. 

Consider these areas when troubleshooting: 

 Does the shared data of the prior revision of the part or BOM in Agile look exactly like the 
current revision of the part or BOM on the target system? Identify all differences and 
similarities. Identify which system is correct, and make appropriate changes to the incorrect 
database to ensure that data will be updated in the next attempt. 

 In Agile, are there effective dates on all affected items? Take corrective action if necessary. 

  you placed all the affected items on the Affected Items tab? Take corrective action 

 In Agile, are there new revisions on all affected items? Take corrective action if necessary. 

In Agile, have

46 Agile Product Lifecycle Management

  



 Chapter 4: Formatting and Transferring Data Files

 

 

if necessary. 

In Agile, have you filled in all required fields? Take corrective action if necessary. (This may  
re-occur.) 

 s to parts and old versus new BOM 

 Have commands to add, modify, and delete parts or BOMs been disabled, or has access been 
changed on the host system? See the target system or database administrator. 

require the Agile administrator to make changes to ensure that this problem does not 

Does the transfer file correctly reflect any change
configurations? Check the ChangeCAST profile. 

 Does the transfer file have the correct mapping of data? Check the ChangeCAST profile. 

 Does ChangeCAST generate the file in the correct format? Check the ChangeCAST profile. 

 Does the transfer file use correct conversion logic for dates, nulls, CR/LF, and so on? Check 
the ChangeCAST profile. 
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